MLA Packet

This MLA packet will help students organize the Works Cited page, format parenthetical references, and apply the basic structure of an MLA paper.

These handouts conform to the MLA Handbook 8th edition standards. However, a professor may change the requirements for individual papers. Please consult the professor for any special requirements.
Sample First Page
(“Formatting a Research Paper,” The MLA Style Center)

Ima Student
Professor Lastname
ENGL 1301.03
13 Jul. 2016

Title of Essay

According to the 8th ed. of the MLA handbook, the last name and page # go on every page (See “Formatting,” par. 6). For details, see “Page Headers,” p. 3 of the packet.

Do not italicize or underline title.

Spacing between all paragraphs, headings, and titles should be the same as between all other lines.

Bottom and top margins are set to 1”.

Tab once before all paragraphs.

Tab twice for quotes longer than 4 lines (MLA Handbook, p. 76).
MLA Basics

Title page (“Formatting,” par. 4)
MLA does not require a separate title page; MLA papers have a four-line heading and a title directly before the first paragraph (see p. 2 of packet). If the professor requires a title page, follow his/her instructions or follow the guidelines for the Generic Title Page, which can be found at http://www3.dbu.edu/uwc/flyers.asp or outside of the Writing Center.

Margins (“Formatting,” par. 2)
Margins should be one inch on all sides of the page. The heading should be set to one inch. In Microsoft Word, select “Page Layout.” Then, find the “Margins” drop-down box and select “Normal.”

Text Formatting (“Formatting,” par. 3)
Many students want to justify the lines of the text at the right margin; however, this is not necessary in MLA format. Instead, choose “Align left,” which is usually the default. If a professor does not request a specific font, use Times New Roman, 12 point. Double-space everything! This includes the title, text, block quotes (quotes longer than four lines), and the Works Cited page. Since double-spacing produces a blank line after paragraphs, headings, and titles, there is no need to press “Enter” to add an extra space. In Microsoft Word, go to the “Home” menu. Then, find the “Paragraph” section and click the small arrow in the bottom right corner. Under the “Line spacing” section, choose “double.” Finally, check the “Don’t add space between paragraphs of the same style” box. For more help, see the video on our YouTube channel: http://www.youtube.com/watch?v=H5bUIVCJltY

Page Headers (“Formatting,” par. 4-6)
MLA calls for both a header and a heading. A header is located half an inch from the top of the page and will include the student’s last name and the page number. This information will appear on every page of the paper. To create the header, double click at the top of the page. Under the “Insert” tab, find the “Page Number” drop down menu, select “Top of Page,” and choose “Plain Number 3.” Then click the left arrow key once so that the cursor is on the left side of the number. Type last name. Make sure to leave one space between the name and the page number, and change the font of both to Times New Roman 12 point. If an extra line appears below the last name and page number, remove it before exiting out of the header.

The heading will appear on the first page only and includes the student’s full name, professor, class designation, and date. When writing the date, include the day, the abbreviated version of the month, and the year (see p. 2 of packet). This header is double-spaced like the rest of the paper and is placed one inch from the top of the page. If the margins are already set correctly, this will be the first line in which the computer will allow typing, outside of the page’s header box (see p. 2 of packet).

Writing the Paper & Citing the Sources

Indents (“Formatting,” par. 3)
Tab once before all paragraphs (half an inch) and tab twice for block quotes (those longer than 4 lines).

Names and Titles (MLA Handbook, pp. 61-75, 116-119)
Within the text of the paper, the first time a source is used, give both the first and last name of the author exactly as they appear in the source. After that, only mention the last name. Italicize the titles of complete works (books, anthologies, newspapers, paintings) and quote unit titles (chapters, articles, essays in a collection, songs).

Using Numbers (MLA Handbook, pp. 92-93)
For a subject, such as literature, that does not regularly use numbers, spell numbers out if they translate into one or two words. Use Arabic numerals with proper comma usage for longer numbers (Ex: 1,576). If a paper frequently uses numbers for mathematics, economics, etc., use the Arabic numerals (1, 2, 3, etc.). If the numbers are not part of a statistic, spell them out (Ex: For fifteen years, Smith has conducted this research).
Citing Sources in an MLA Paper (MLA Handbook, pp. 54-58, 75-91, 116-127)
In parentheses, after the quote or paraphrase, type the author’s last name and the page number without a comma between them (see “Differences in Quoting, Paraphrasing, and Summarizing” flyer).

Works Cited Page (MLA Handbook p. 20, “Formatting,” par. 7)
If sources have been cited within the paper, it is necessary for a Works Cited page to come at the end. Double-space everything on the Works Cited page. The first line of each reference is aligned left and each following line is indented once. This is called a hanging indent. See p. 5 of this packet or our YouTube tutorial (https://www.youtube.com/watch?v=S2fg4JFHnkM) for instructions on creating a hanging indent.

Sources in the Paper – Parenthetical Notation (MLA Handbook, pp. 54-58, 116-127)

<table>
<thead>
<tr>
<th>Circumstance</th>
<th>What to Include in Parentheses</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author’s name omitted from the sentence</td>
<td>Author’s last name and page number.</td>
<td>(Smith 41). See MLA Handbook p. 54.</td>
</tr>
<tr>
<td>Author’s name included in the sentence</td>
<td>Page number only.</td>
<td>According to Smith… (123). See MLA Handbook p. 54.</td>
</tr>
<tr>
<td>Multiple works by the same author</td>
<td>Author’s last name, one major word from the title of the work, and page number with no</td>
<td>(Smith, Characters 98).</td>
</tr>
<tr>
<td></td>
<td>comma between title and page number</td>
<td>See MLA Handbook p. 55.</td>
</tr>
<tr>
<td>A work with two authors</td>
<td>Both authors’ last names in the order they appear on the title page.</td>
<td>(Gray and Dunn 75). See MLA Handbook p. 116</td>
</tr>
<tr>
<td>A work with three or more authors</td>
<td>First author listed, followed by “et al.”</td>
<td>(McFluffy et al. 1337). See MLA Handbook p. 116</td>
</tr>
<tr>
<td>A work with no author</td>
<td>The word by which the title is alphabetized in the Works Cited and the page number. <em>Italicize</em></td>
<td>(“Dreams” 52-53). See MLA Handbook p. 55-56.</td>
</tr>
<tr>
<td>A work with no page numbers</td>
<td>It is preferable to use the author and title in the text, only including the paragraph number</td>
<td>John Krasinski’s <em>How to Prank Your Coworkers</em> claims that the… (par. 4). or (Krasinski par. 4).</td>
</tr>
<tr>
<td></td>
<td>in the parenthetical notation. Otherwise, use author’s last name as well as the paragraph</td>
<td>See MLA Handbook p. 56.</td>
</tr>
<tr>
<td></td>
<td>number in the parenthetical notation.</td>
<td></td>
</tr>
<tr>
<td>A multivolume work</td>
<td>Author or editor, followed by volume number, a colon, then page numbers.</td>
<td>(Darnel 3: 212-13). See MLA Handbook pp. 119-20.</td>
</tr>
<tr>
<td>A document from the internet with no page numbers or paragraphs</td>
<td>Preferable to use the author and title in the text. Otherwise, use author’s last name in the</td>
<td>Dwight Schrute’s <em>Bears, Beets, Battlestar Galactica</em> claims that the… (Schrute)</td>
</tr>
<tr>
<td></td>
<td>parenthetical notation.</td>
<td>See MLA Handbook p. 56.</td>
</tr>
<tr>
<td>An electronic book with universally inconsistent location and page numbers</td>
<td>Author’s last name and the chapter number.</td>
<td>(Jones ch. 5). See MLA Handbook p. 123.</td>
</tr>
<tr>
<td>A poem</td>
<td>Line numbers. A slash is placed between each line. If more than three lines, indent each new</td>
<td>“I learned about a virgule. / It is another name for slash (Griffin 332-33). See MLA Handbook pp.</td>
</tr>
<tr>
<td></td>
<td>line instead of using slashes</td>
<td>121-22.</td>
</tr>
<tr>
<td>A play</td>
<td>Act number, scene number, line number(s), separated by periods.</td>
<td>(2.5.79-81). See MLA Handbook p. 121.</td>
</tr>
<tr>
<td>Indirect Source</td>
<td>Use the abbreviation “qtd. in” before citation.</td>
<td>(qtd. in Rogers 4). See MLA Handbook p. 124.</td>
</tr>
</tbody>
</table>
With non-blocked quotes (those of 4 lines or less), the period goes after the end parenthesis. With block quotes, type a space after the ending punctuation mark of the quotation and then type the parenthetical reference. Do not use quotation marks.

This is an example of what the last line of a block quote should look like:

```
Playing with The Grass Roots was much more difficult than playing the role of Creed on The Office. (Creed Bratton 115)
```

**Printed Sources in the Works Cited (MLA Handbook pp. 20-53, 102-16)**

- Double-space the lines of the Works Cited page.
- Include available author, title, and publishing information in each entry. For publishing companies containing the words “press” or “university” use “P” and “U,” respectively (E.g. HarperCollins P, Dallas Baptist U).
- Arrange entries in alphabetical order by author’s last name. Use the first author if a work has several. If there is no author named, alphabetize the entry by the first significant word of the title (i.e. *The Season of Surgery* before *Summertime Love*).
- Align entries to the left and indent subsequent lines one tab. To automatically create a hanging indent, highlight the Works Cited list, click the small arrow button in the bottom right of the “Paragraph” section of the “Home” tab, find the “Special” section under “Indention,” and choose “Hanging.” For more help, see this video on our YouTube channel: http://www.youtube.com/watch?v=S2fg4JFHnkM
- Remember to use one space after a comma or period and finish each entry with a period.
- Some sources are part of a larger whole, such as an article in a newspaper or magazine. The larger whole can be thought of as a container, which is italicized and followed by a comma because the information that follows is about the container, not the article (pp. 30-31).
- If there are volume or issue numbers, include them after the title of the publication in the format volume number, period, no space, issue number (See the “Scholarly Journal” section on p. 6 of this packet for an example).

**Book with One Author (MLA Handbook, p. 21)**

*Electronic books are also cited in this way on a Works Cited page.*

**Book with Two Authors (MLA Handbook, p. 21)**

**Book with Three or More Authors (MLA Handbook, p. 22)**

**Two or More Books by the Same Author (MLA Handbook, p. 113)**


*Cite the first normally. Use three hyphens and a period for every subsequent entry. They should be together in the Works Cited page.*
An Edition other than the First (*MLA Handbook*, pp. 38-39)

**Book with an Editor as Author (MLA Handbook, pp. 22-23)**

**Book with an Author and Editor (MLA Handbook, pp. 37-38)**

**A Work in an Anthology (with an author) (MLA Handbook, p. 38)**

*Include the page numbers of the entire work, not just the portion quoted.

*Because the specific work was translated, the translator comes before the complete collection, also known as the container. The details about the container follow its name and are separated by commas.

**A Work in an Anthology (with no author) (MLA Handbook, pp. 24, 38)**

*Include page numbers of the entire work, not just the portion quoted.

*In this instance, *Gilgamesh* is the primary source, and therefore, the details following are separated from the title with a period. The container’s details, however, are still separated by commas.

**A Multivolume Work (MLA Handbook, p. 39)**

*The total number of volumes in a multivolume publication is optional and not required and may aid in tracking down the original source. However, specific references to volume number and page numbers must be included in the parenthetical reference.

**Newspaper Article (MLA Handbook, p. 16)**

*If edition (late edition., special edition., etc.) is needed, it goes after the periodical title, separated by a comma.

*Newspaper page numbers are denoted by the page number of the section in which the article resides. In the example above, 1A refers to page 1 of section A.

**Scholarly Journal (MLA Handbook, pp. 39-40)**

* no. 2 represents the journal issue number 2.
Electronic Sources in the Works Cited

For the most part, the same important information for a printed source must be reported for electronically accessed sources. However, there are a few extra items that are very important to include. The Internet is constantly changing, so while it is not required, it is recommended to include the date the article was accessed.

World Wide Web (MLA Handbook, pp. 48, 53)

When citing an item from the World Wide Web, include as much of the following information as the item provides. For example, if the material being cited does not have an author’s name, the name can be left out in the Works Cited, and the student can move on to the next step.

- Name of author, compiler, director, editor, narrator, performer, or translator of the work
- Title of document, in quotation marks
- Title of complete work (or site name), italicized
- Date of publication or last revision; if nothing is available, use n.d. (no date).
- MLA recommends the use of an URL address, but the professor has the right to ask that it not be used.
- If there is no other date provided, the date of access may be added at the end of an entry (e.g. “Accessed 27 Sept. 1995”).
- Because the publisher of a web article can change the URL anytime they desire, a digital object identifier (DOI) might be preferable, if one can be found. This would be added at the end of the entry (e.g. “Steve, Graham, et al. “Assessing the Writing Achievement of Young Struggling Writers.” Hammill Institute on Disabilities, vol. 39, no. 2, 2016, pp. 72-75, doi: 10.1177/0731948714555019.”).

General Website Entry (MLA Handbook, pp. 27-28, 30, 48)


Printed Book Accessed Through the Internet (MLA Handbook, pp. 27, 30, 34, 44)


Printed Newspaper Article Accessed Through the Internet (MLA Handbook, pp. 27-28, 30, 32, 42-43)


Electronic Journal or Magazine Article (MLA Handbook, pp. 27-28, 30, 32, 44)


Professional Site (MLA Handbook, pp. 27, 41, 44)

Professional Site Poems and Short Stories (in an Online Anthology) (MLA Handbook, pp. 27, 35)

Scholarly Project (MLA Handbook, pp. 28, 30, 41, 44)

Online Database Accessed from a library (MLA Handbook, pp. 28, 30, 32, 44)

*If there are no page numbers, use “n. pag.” instead: 1999, n. pag.
*Academic OneFile is one of the DBU databases. It acts as the container of the Science journal and is known as the secondary container because Science is the container of the article.

Twitter (MLA Handbook, pp. 24, 29)
@pseudonym. “Tweet or status in its entirety.” Twitter, Day Month Year, time. www.url.com.

@dinnerquotes. “I just ate dinner, and it was delicious.” Twitter, 4 Mar. 2013, 9:32 p.m.

YouTube (MLA Handbook, pp. 28, 38, 44, 48)

*When using YouTube, determine whether or not it is original material first. In other words, is it available from another, more reliable, source?
*Cite everything possible about the material, creator/username, title, and publication data.
*If specific people are used in the source, such as the creator or actors, be sure to include information about them similar to the way the “uploader” is cited (e.g. “performance by Herbious Meowmix,”)

Online Show or Movie (MLA Handbook, pp. 28, 30, 33, 40-43, 53)

Miscellaneous Communication

Published/Broadcast Interview (MLA Handbook, pp. 28, 38, 52)

Electronic Communications (MLA Handbook, p. 29)
When citing electronic communications, the method will be somewhat different. Please notice the list below for items to include when citing an e-mail message.
- Author’s name
- Subject line from posting (in quotation marks)
- Recipient (e.g. “Received by Herbious Meowmix,”)
- Date of publication
Personal Interview (*MLA Handbook, pp. 28-29*)

**Using the Bible as a Source (pp. 97-99, 122)**

**Things to Remember**

- The first time a particular version is cited, include the version, followed by a comma. The version does not have to be stated in subsequent references unless a different version is used.
- The book of the Bible cited should be abbreviated.
- When citing chapter and verse, it is appropriate to separate them by either a colon or a period. Always be consistent.

*Ex: Before God created light, “darkness was over the surface of the deep” (New International Version, Gen. 1.2). After God separated the light from the darkness, “the darkness he called ‘night’” (Gen. 1.5).*

**Parenthetical References (MLA Handbook, pp. 97-99, 122-123)**

When citing a particular passage, use the following order:
(version of Bible used [in first citation only], book of Bible [abbreviated] chapter. verse).

*Ex: (New International Version, Gen. 1.1).*

**In Your Text**

Books and versions of the Bible are not underlined, italicized, or put in quotation marks. The only exception is when an individually published edition is being used.

*Ex: Bible  Exodus  New Testament  King James Version  The Zondervan Study Bible*

*Ex: The NIV Serendipity Bible* provides questions to assist small group Bible study leaders.

**Works Cited (MLA Handbook, pp. 37-38, 107, 123)**

Include title of Bible, version, and publication information in the Works Cited.


**Reference Resources (MLA Handbook, pp. 37, 39, 51-52)**


*The total number of volumes in a multivolume publication is optional and not required but may aid in tracking down the original source.*
**Abbreviations (MLA Handbook, pp. 97-99)**

### Old Testament

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Gen.</td>
<td>Genesis</td>
<td>Eccles.</td>
<td>Ecclesiastes</td>
</tr>
<tr>
<td>Exod.</td>
<td>Exodus</td>
<td>Song Sol.</td>
<td>Song of Solomon</td>
</tr>
<tr>
<td>Lev.</td>
<td>Leviticus</td>
<td>Isa.</td>
<td>Isaiah</td>
</tr>
<tr>
<td>Num.</td>
<td>Numbers</td>
<td>Jer.</td>
<td>Jeremiah</td>
</tr>
<tr>
<td>Deut.</td>
<td>Deuteronomy</td>
<td>Lam.</td>
<td>Lamentations</td>
</tr>
<tr>
<td>Josh.</td>
<td>Joshua</td>
<td>Ezek.</td>
<td>Ezekiel</td>
</tr>
<tr>
<td>Ruth</td>
<td>Ruth</td>
<td>Hos.</td>
<td>Hosea</td>
</tr>
<tr>
<td>1 Sam.</td>
<td>1 Samuel</td>
<td>Joel</td>
<td>Joel</td>
</tr>
<tr>
<td>2 Sam.</td>
<td>2 Samuel</td>
<td>Amos</td>
<td>Amos</td>
</tr>
<tr>
<td>1 Kings</td>
<td>1 Kings</td>
<td>Obad.</td>
<td>Obadiah</td>
</tr>
<tr>
<td>2 Kings</td>
<td>2 Kings</td>
<td>Jon.</td>
<td>Jonah</td>
</tr>
<tr>
<td>1 Chron.</td>
<td>1 Chronicles</td>
<td>Mic.</td>
<td>Micah</td>
</tr>
<tr>
<td>2 Chron.</td>
<td>2 Chronicles</td>
<td>Nah.</td>
<td>Nahum</td>
</tr>
<tr>
<td>Ezra</td>
<td>Ezra</td>
<td>Hab.</td>
<td>Habakkuk</td>
</tr>
<tr>
<td>Neh.</td>
<td>Nehemiah</td>
<td>Zeph.</td>
<td>Zephaniah</td>
</tr>
<tr>
<td>Esth.</td>
<td>Esther</td>
<td>Hag.</td>
<td>Haggai</td>
</tr>
<tr>
<td>Job</td>
<td>Job</td>
<td>Zech.</td>
<td>Zechariah</td>
</tr>
<tr>
<td>Ps.</td>
<td>Psalms</td>
<td>Mal.</td>
<td>Malachi</td>
</tr>
<tr>
<td>Prov.</td>
<td>Proverbs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### New Testament

<table>
<thead>
<tr>
<th>New Testament Abbreviation</th>
<th>New Testament Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matt.</td>
<td>Matthew</td>
</tr>
<tr>
<td>Mark</td>
<td>Mark</td>
</tr>
<tr>
<td>John</td>
<td>John</td>
</tr>
<tr>
<td>Acts</td>
<td>Acts</td>
</tr>
<tr>
<td>Rom.</td>
<td>Romans</td>
</tr>
<tr>
<td>1 Cor.</td>
<td>1 Corinthians</td>
</tr>
<tr>
<td>2 Cor.</td>
<td>2 Corinthians</td>
</tr>
<tr>
<td>Gal.</td>
<td>Galatians</td>
</tr>
<tr>
<td>Eph.</td>
<td>Ephesians</td>
</tr>
<tr>
<td>Phil.</td>
<td>Philippians</td>
</tr>
<tr>
<td>Col.</td>
<td>Colossians</td>
</tr>
<tr>
<td>1 Thess.</td>
<td>1 Thessalonians</td>
</tr>
<tr>
<td>2 Thess.</td>
<td>2 Thessalonians</td>
</tr>
</tbody>
</table>